## SIMATIC HMI

### WinCC

### Getting Started

**Manual**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparation and Installation</td>
<td>1</td>
</tr>
<tr>
<td>Your first WinCC project</td>
<td>2</td>
</tr>
<tr>
<td>Display Process Values</td>
<td>3</td>
</tr>
<tr>
<td>Configuring Messages</td>
<td>4</td>
</tr>
<tr>
<td>Printing the Message Sequence Report</td>
<td>5</td>
</tr>
<tr>
<td>Printing a Tag Logging Runtime Report</td>
<td>6</td>
</tr>
<tr>
<td>Client/Server Operation</td>
<td>7</td>
</tr>
</tbody>
</table>
WinCC®, SIMATIC®, SIMATIC NET®, SINEC® and STEP® are Siemens registered trademarks.

All other product and system names in this manual are (registered) trademarks of their respective owners and must be treated accordingly.

(The reproduction, transmission or use of this document or its contents is not permitted without express written authority. Offenders will be liable for damages. All rights, including rights created by patent grant or registration of a utility model or design, are reserved.)

(We have checked the contents of this manual for agreement with the hardware and software described. Since deviations cannot be precluded entirely, we cannot guarantee full agreement. However, the data in this manual are reviewed regularly and any necessary corrections included in subsequent editions. Suggestions for improvement are welcomed.)

© Siemens AG 1994 - 2000 All rights reserved

6ZB5370-0CM02-0BA4
Printed in the Federal Republic of Germany

Technical data subject to change

Siemens Aktiengesellschaft
Contents

1 Preparation and Installation.............................................................................. 1
  1.1 WinCC Hardware Prerequisites ................................................................. 1
  1.2 Required Operating System ...................................................................... 1
  1.3 WinCC Installation and Setup ................................................................... 2
    1.3.1 WinCC Installation: User Registration ............................................... 3
    1.3.2 Installation: Select language ............................................................... 4
    1.3.3 Installation: Select components .......................................................... 5
    1.3.4 Installation: Authorization ................................................................ 7
  1.4 Installation: Tag Simulator ....................................................................... 8
  1.5 Deinstallation ............................................................................................ 9
  1.6 Troubleshooting and Fault Correction .................................................... 10

2 Your first WinCC project .............................................................................. 11
  2.1 Step 1: Starting WinCC ........................................................................... 12
  2.2 Step 2: Creating a New Project ............................................................... 12
  2.3 Step 3: Add PLC Driver ......................................................................... 14
  2.4 Tags and Tag Groups ............................................................................. 16
    2.4.1 Step 4: Creating Internal Tags ........................................................... 17
    2.4.2 Step 4a: Creating a Tag Group ......................................................... 19
    2.4.3 Step 4b: Creating Process Tags ......................................................... 21
  2.5 Editing Process Pictures ........................................................................ 25
    2.5.1 Step 5.1: Creating Process Pictures ................................................ 25
    2.5.2 The Graphics Designer ..................................................................... 27
    2.5.3 The Process Picture .......................................................................... 29
    2.5.4 Step 5.2: Creating a Button ............................................................... 30
    2.5.5 Step 5.3: Configuring the Process Picture ....................................... 31
    2.5.6 Step 5.4: Dynamise the Fill Level Display ...................................... 33
    2.5.7 Step 5.5: Creating and Dynamising an I/O-Field ............................ 37
  2.6 Step 6: Setting Runtime Properties ....................................................... 39
  2.7 Step 7: Activate the Project ................................................................. 40
  2.8 Step 8: Using the Simulator ................................................................... 41

3 Display Process Values.............................................................................. 43
  3.1 Step 1: Open Tag Logging .................................................................... 44
  3.2 Step 2: Timer Configuration .................................................................. 44
  3.3 Step 3: Creating an Archive .................................................................. 46
  3.4 Step 4: Creating a Trend Window ......................................................... 49
  3.5 Step 5: Creating a Table Window .......................................................... 51
  3.6 Step 6: Setting Runtime Properties ...................................................... 54
  3.7 Step 7: Activating the Project .............................................................. 55

4 Configuring Messages ............................................................................... 57
  4.1 Step 1: Opening Alarm Logging ............................................................ 58
  4.2 Step 2: Starting the System Wizard ....................................................... 59
  4.3 Step 3: Message Text Configuration ..................................................... 61
  4.4 Step 4: Configuring Message Colors ................................................... 64
  4.5 Monitoring of Limit Values .................................................................... 66
    4.5.1 Step 5.1: Configuring the Monitoring of Limit Values ..................... 66
    4.5.2 Step 5.2: Setting Limit Values ......................................................... 70
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.6</td>
<td>Step 6: Creating a Message Picture</td>
<td>73</td>
</tr>
<tr>
<td>4.7</td>
<td>Step 7: Setting Runtime Properties</td>
<td>76</td>
</tr>
<tr>
<td>4.8</td>
<td>Step 8: Activating the Project</td>
<td>77</td>
</tr>
<tr>
<td>5</td>
<td>Printing the Message Sequence Report</td>
<td>79</td>
</tr>
<tr>
<td>5.1</td>
<td>Step 1: Activate the Message Sequence Report</td>
<td>80</td>
</tr>
<tr>
<td>5.2</td>
<td>Step 2: Editing the Layout</td>
<td>81</td>
</tr>
<tr>
<td>5.2.1</td>
<td>Step 2.1: Open Layout</td>
<td>81</td>
</tr>
<tr>
<td>5.2.2</td>
<td>Step 2.2: The Report Designer</td>
<td>82</td>
</tr>
<tr>
<td>5.2.3</td>
<td>Step 2.3: Editing the Layout</td>
<td>84</td>
</tr>
<tr>
<td>5.3</td>
<td>Step 3: Setting the Print Job Parameters</td>
<td>88</td>
</tr>
<tr>
<td>5.4</td>
<td>Step 4: Setting Runtime Properties</td>
<td>89</td>
</tr>
<tr>
<td>5.5</td>
<td>Step 5: Activating the Project</td>
<td>90</td>
</tr>
<tr>
<td>6</td>
<td>Printing a Tag Logging Runtime Report</td>
<td>91</td>
</tr>
<tr>
<td>6.1</td>
<td>Step 1: Creating a Layout</td>
<td>92</td>
</tr>
<tr>
<td>6.2</td>
<td>Step 2: Editing the Layout</td>
<td>93</td>
</tr>
<tr>
<td>6.2.1</td>
<td>Step 2.1: Editing the Static Portion</td>
<td>93</td>
</tr>
<tr>
<td>6.2.2</td>
<td>Step 2.2: Editing the Dynamic Portion</td>
<td>94</td>
</tr>
<tr>
<td>6.3</td>
<td>Step 3: Setting the Print Job Parameters</td>
<td>97</td>
</tr>
<tr>
<td>6.4</td>
<td>Step 4: Activating the Project</td>
<td>98</td>
</tr>
<tr>
<td>7</td>
<td>Client/Server Operation</td>
<td>99</td>
</tr>
<tr>
<td>7.1</td>
<td>Client/Server Systems</td>
<td>100</td>
</tr>
<tr>
<td>7.2</td>
<td>Step 1: Creating a Multi-User System</td>
<td>101</td>
</tr>
<tr>
<td>7.3</td>
<td>Step 2: Connecting a Client</td>
<td>102</td>
</tr>
<tr>
<td>7.4</td>
<td>Step 3: Setting the Client’s Runtime Properties</td>
<td>103</td>
</tr>
<tr>
<td>7.5</td>
<td>Step 4: Opening a Project on the Client</td>
<td>105</td>
</tr>
<tr>
<td>7.6</td>
<td>Step 5: Different Start Pictures on the Client and Server</td>
<td>106</td>
</tr>
<tr>
<td>7.7</td>
<td>Step 6: Activating the Project</td>
<td>107</td>
</tr>
</tbody>
</table>
Welcome to WinCC - the Windows Control Center for Windows NT 4.0.

WinCC is the world’s first IHMI (Integrated Human Machine Interface) software system, which truly integrates your plant controller software with your automation process. WinCC’s user-friendly components permit the trouble-free integration of new or existing applications.

With WinCC, you have a process visualization program that enables you to easily observe all aspects of your automation processes.

WinCC combines the modern architecture of Windows NT 4.0 applications with the simplicity of a graphic design program. WinCC includes all the elements necessary for solving process monitoring and control tasks:

The WinCC Project Engineering Environment

- Pictures - to design plant representations
- Archiving - to store data/events, with a time stamp, in a SQL database
- Report Designer - to generate reports for the requested data
- Data Management - to define and collect data throughout the plant

WinCC Runtime

- Enables machine operators, who are on the plant floor or in a control room, to interact with the machine application.
Notation

In this documentation, the following notation is being used:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="left_click" /></td>
<td>indicates a click of the left mouse button.</td>
</tr>
<tr>
<td><img src="image" alt="right_click" /></td>
<td>indicates a click of the right mouse button.</td>
</tr>
<tr>
<td><img src="image" alt="double_click" /></td>
<td>indicates a double-click of the left mouse button.</td>
</tr>
<tr>
<td><img src="image" alt="entry" /></td>
<td>indicates an entry with the left mouse button depressed.</td>
</tr>
<tr>
<td><img src="image" alt="keyboard" /></td>
<td>indicates an entry on the keyboard.</td>
</tr>
<tr>
<td>&quot;File&quot; — &quot;New&quot;</td>
<td>all the given menus and input fields, which are selected, are shown in quotations.</td>
</tr>
<tr>
<td>#1</td>
<td>In the text accompanying the pictures, the &quot;#n&quot; specifies the order in which the steps should be performed.</td>
</tr>
</tbody>
</table>
1 Preparation and Installation

This chapter describes the WinCC hardware and operating system prerequisites, the installation procedure for the CD-ROM, as well as the configuration of the work environment.

1.1 WinCC Hardware Prerequisites

WinCC supports all common IBM/AT-compatible PC platforms. Although values are given for a minimum configuration, to efficiently operate WinCC, you should aim for the values recommended for the optimum configuration.

<table>
<thead>
<tr>
<th></th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>INTEL Pentium II 266 MHz</td>
<td>INTEL Pentium II 400 MHz</td>
</tr>
<tr>
<td>RAM</td>
<td>96 MB</td>
<td>128 MB</td>
</tr>
<tr>
<td>Graphic Controller</td>
<td>SVGA (4 MB)</td>
<td>XGA (8 MB)</td>
</tr>
<tr>
<td>Resolution</td>
<td>800 * 600</td>
<td>1024 * 768</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>500 MB available space</td>
<td>&gt; 500 MB available space</td>
</tr>
<tr>
<td></td>
<td>CD-ROM Drive</td>
<td>CD-ROM Drive</td>
</tr>
</tbody>
</table>

Note

The performance of the system is dependent on the number of tags used and the amount of memory available.

Please note that, if other programs are started, this can also reduce the performance.

1.2 Required Operating System

WinCC can only run under Windows NT 4.0 (Workstation or Server) when at least Service Pack 5 is installed.
1.3 **WinCC Installation and Setup**

WinCC is delivered on a CD-ROM, which has an Autorun program. Simply insert the CD-ROM in the drive and the installation will begin automatically.

After a brief time for loading, the following installation dialog will be displayed:

![WinCC Installation Dialog]

To see further information about WinCC, or to install various utilities such as the tag simulator, click on the text "Welcome", "Read First", "Display CD-ROM Contents", "Install SIMATIC WinCC", "Install Tools and Drivers", "Language Selection".

To install WinCC, click on the text "Install SIMATIC WinCC". The installation wizard will then guide you through the installation procedure step-by-step.

In the next dialog box, click on the "Next" button to proceed to the next step.

Read the license conditions and then click on "Yes" to confirm that you accept them.
1.3.1 WinCC Installation: User Registration

Enter the necessary data in the "User Information" dialog box.

![User Information dialog box]

Enter the word "Demo" in this field. Afterwards, click on "Next".

Afterwards, click on "Next".

In the next dialog box, "Registration Confirmation", confirm your entries by clicking on "Yes".
1.3.2 Installation: Select language

In the next dialog select the desired language (the system selects English by default) and the destination directory in which you wish to install WinCC. The standard directories are "C:\Siemens\WinCC" and "C:\Siemens\Common".

Afterwards, click on "Next".
1.3.3 **Installation: Select components**

The WinCC Setup program offers you three basic options for the WinCC installation. For the maximum installation (you can select all components), please select "User-defined" installation.

![Figure 1.4: Installing WinCC; User-defined Installation](image)

*Figure 1.4: Installing WinCC; User-defined Installation*
In the “Select Components” dialog, select the components you wish to install. To do so, click on the desired component in the left window, and their elements will then be displayed in the right window. In the right window, you can then select the individual elements. To select components/elements, click on the check box in front of the desired component or element. Selected components/elements are identified by a check mark in the box. The amount of memory required will be displayed together with amount available.

Figure 1.5: Installing WinCC; Selecting the components

Afterwards, click on "Next".
1.3.4 Installation: Authorization

The "Authorization" dialog displays a list of required authorizations based on the selected components. Since the authorization can also be performed later, select "No, the Authorization is performed at a later time". Please consider that, without an authorization, WinCC only runs in demo mode and will automatically shut down after an hour.

![Authorization dialog](image)

*Figure 1.6: WinCC Installation; Authorization*

Afterwards, click on "Next".

In the next dialog box, you will be shown the settings you have made. If you wish to change the settings, click on "Back", otherwise click on "Next". WinCC will now begin to transfer the files. Once it is done, you can read the "README.TXT" file.

To complete the installation, click on "Yes, restart the computer now".
1.4 Installation: Tag Simulator

To enable us to observe the changes in the tag values at runtime, we will use the tag simulator. This is found on the WinCC CD-ROM under "SmartTools". Place the CD-ROM in the drive. The Setup program will start automatically.

To install the Simulator, click with the left mouse button on the text "Tools and Drivers".

Click with the left mouse button on the text "WinCC - Simulator". The installation wizard will then guide you through the installation procedure step-by-step.

In the next dialog box, click on the "Next" button to proceed to the next step.

Read the license conditions and then click on "Yes" to confirm that you accept them.

In the next dialog, select the directory in which you wish to install the Simulator. The standard directory is "C:\Siemens\WinCC\SmartTools\Simulator".

Afterwards, click on "Next". The files will now be transferred. When this is done, you must restart the computer.

To complete the installation, click on "Yes, restart the computer now".
1.5 Deinstallation

Under Windows NT 4.0, WinCC can be deinstalled via the "Install/Uninstall" panel in "Add/Remove Programs Properties", which is found in the Control Panel.

1. To deinstall WinCC, in "My Computer", select the "Control Panel" and then double-click on the "Add/Remove Programs" icon.

2. In the "Install/Uninstall" panel of the dialog box, first click on "SIMATIC WinCC" and then on the "Add/Remove" button.

3. After a few dialog boxes, you will be presented with a number of options for the deinstallation. To remove WinCC completely, please click on the top button. To remove or install WinCC components, please click on the middle button. To remove or install a language, please click on the bottom button.

4. Click on "Start" to begin the deinstallation. Once the deinstallation is completed, click on the "OK" button (your computer will then be restarted).

The following WinCC components will not be deleted:

- Any projects you have developed.
- The "Active X" objects that were delivered with WinCC (WinCC Slider, WinCC Push Button, WinCC D/A-Clock).
1.6 Troubleshooting and Fault Correction

WinCC cannot setup a connection to the SQL database

The "SQL Anywhere" database is started together with WinCC. The NetBIOS name of your computer will be used for the name of the database engine. If this name includes a dash (-) or space, it will not be possible to setup a link between WinCC and the database.

To change the NetBIOS name, please click on the "Network" icon in Windows Control Panel. The computer name can be changed in the "Identification" panel.

Permissible names include:
- James_Bond
- MyMachine2

Impermissible names include:
- My Machine
- James Bond
- my-server

The SQL database cannot be started

Although WinCC analyses the "Path" entry for your computer during the installation and attempts to insert a path to the correct location, under some circumstances, this operation may fail.

To check whether the path was properly entered during the installation, please enter the "SET" command at the DOS prompt. The following entries must be in the path:

"<installation dir>\BIN" and "<installation dir>\SQLANY"

"SQLANY=<installation dir>\SQLANY".

Occasionally, there may be two path lines. In this case, make certain that the second path includes the macro "%PATH%", since otherwise the first path will be overwritten by the second.

The icons for the program group are not visible

WinCC uses a user-dependent Program Manager to display the icons. If you have not logged into the computer with the same name as you used when you installed WinCC, the WinCC icons will not be displayed.
2 Your first WinCC project

This chapter presents the basic components of WinCC and provides an overview of the most important editors with the aid of simple examples.

To create a project in WinCC, please proceed as follows:

1. Start WinCC.
2. Create a project.
3. Select and install a PLC or a driver.
4. Define the tags.
5. Create and edit your process pictures.
6. Set your WinCC Runtime properties.
7. Activate your pictures in WinCC Runtime.
8. Use the simulator to test your process pictures.
2.1 Step 1: Starting WinCC

- To start WinCC, please click on the “Start” in the Windows NT taskbar.
- Start WinCC via “SIMATIC” → "WinCC" → "Windows Control Center".

![Figure 2.1: WinCC Project “Qckstart”; Starting WinCC from the Start Taskbar](image)

2.2 Step 2: Creating a New Project

When you open WinCC for the first time, a dialog box will open offering three options for creating a project:

- Create “Single-User Project” (default)
- Create “Multi-User Project”
- Create “Multi-Client Project”
- “Open an Available Project”

Creating the Quickstart Project:

- Select “Single-User Project” and confirm with the “OK” button.
- Enter “Qckstart” as the project name and select a project path. You can rename the subdirectory if you wish, otherwise it will be given the same name as the project.

If you want to open an existing project, the “Open” dialog will allow you to search for files with the extension “.mcp”. The next time you start WinCC, it will automatically reopen the last project you worked on. If the project was activated when you exited WinCC, it will be reopened in the activated state.
WinCC Explorer is shown in Figure 2.2 (the dialog boxes may differ slightly from the illustration depending on the configuration).

![WinCC Explorer](image)

**Figure 2.2.: WinCC Project "Qckstar"; WinCC Explorer Dialog Window**

In the left subwindow, you see the root of the hierarchy, which leads you to the individual project steps. Hidden parts are marked with the ♦ symbol. To make a hidden part visible, click on this symbol.

The right subwindow shows the contents of the selected point.

In the left subwindow of the WinCC Explorer, click on the "Computer" icon 🏛️. In the right subwindow, you should then see a Server with your computer's name (the NetBIOS name). With the right mouse button, click on this computer and select "Properties" in the pop-up menu. In the following dialog box, you can set the WinCC runtime system’s properties, such as, which programs should be started, which language should be used and which keys should be deactivated.

---

**Note**

If your computer does not have a NetBIOS name, it will be called "DEFAULT".
2.3 Step 3: Add PLC Driver

In the next step, we will configure our system so that our AS can communicate with WinCC via the selected communication driver. Driver selected depends on the PLC used. The Siemens SIMATIC PLC Family ranges from a few hundred to several thousand I/O points.

To add a PLC driver, click in the left subwindow of WinCC Explorer with the right mouse button on “Tag Management”.

In the pop-up menu, click on "Add New Driver”.

In the “Add new driver” dialog, select one of the displayed drivers (e.g. "SIMATIC S7 Protocol Suite") and confirm by clicking on the "Open” button. The selected driver will then appear under the Tag Management line.

To create a new connection, click on the icon in front of the displayed driver - all the available channel units will be displayed.

Click with the right mouse button on the channel unit MPI.

In the pop-up menu, click on "New Connection”.

Figure 2.3.1: WinCC Project “Qckstart”; Add Driver Connection
In the "Connection properties" dialog box, which appears afterwards, enter "PLC1" in the name field.

Then click on "OK" to confirm.
2.4 Tags and Tag Groups

The tags used in WinCC represent either real values, such as the fill level of a water tank, or internal values calculated or simulated within WinCC.

Process tags ("external tags", "PowerTags") are memory locations within a PLC or a similar device. Thus, as an example, the fill level of the water tank will be determined by a fill level sensor and saved in the PLC. Via a connection, the communications channel will pass the fill level value to WinCC.

Internal tags are memory locations within WinCC, which deliver the same functionality as a PLC. They can be calculated and modified within WinCC.

Tag groups serve to organize tags in structures. All the tags can be organized in tag groups to improve clarity.

---

**Note**

Although we only used internal tags in our project, you need not perform steps 4a and 4b. The configuration of tag groups and process tags is illustrated in these steps.

---

The Hierarchy of Tag Management with Process Tags

```
Tag Management
SIMATIC S7 PROTOCOL SUITE
  MPI
  PLC 1
  Tag Group
  Tag
```

The Hierarchy of Tag Management with Internal Tags

```
Tag Management
  Tag group
  Tag
```
2.4.1 Step 4: Creating Internal Tags

If the "Tag Management" node in WinCC Explorer is still closed, you must first open it by double-clicking on it.

Afterwards, click with the right mouse button on the line "Internal Tags"

In the pop-up menu, click on "New Tag".

Figure 2.4.1: WinCC Project "Qckstart"; Creating an Internal Tag
In the "Tag Properties" dialog, name the tag "TankLevel".

From the list of data types, select "Unsigned 16-bit value".

Confirm your entry by clicking on "OK".

![Tag properties dialog box](image)

Figure 2.4.2: WinCC Project "Qckstart"; Properties of an Internal Tag

All of the internal tags that you create will be listed in the subwindow on the right in the WinCC Explorer window.

It is just this simple to create a tag. For each tag you need, simply repeat these steps. You can also "Copy", "Cut", and "Paste" tags. You can also select these commands in the pop-up menu (click with the right mouse button on the desired tag) or use the standard Microsoft key combinations (Ctrl+C = copy, Ctrl+V = paste).
2.4.2 Step 4a: Creating a Tag Group

**Note**

It is not necessary to create a tag group to reconstruct the example project.

Tag groups can, for example, be organized below the logical PLC connection. To create a new group, click with the right mouse button on the PLC connection you created.

In the pop-up menu, click on "New Group".

*Figure 2.4.3: WinCC Project "Qckstart"; Creating a New Tag Group*
In the "Properties of tag group" dialog, which is then displayed, enter a name for the group.

Afterwards, click on "OK"

The tag group will then be displayed under the PLC connection.
2.4.3 Step 4b: Creating Process Tags

Note
To reconstruct the example project, it is not necessary to create a process tag.

Before you can create a process variable, you must have installed a driver and created a connection.

Internal tags, which you have already created, can be copied and pasted in your connection. Please note that tags can only be placed in a connection with the commands “Copy” and “Paste”. Tags cannot be dragged into a connection.

To create process tags, click with the right mouse button on your PLC connection.

In the pop-up menu, click on “New Tag”.

![Figure 2.4.5: WinCC Project "Qckstart"; Creating an Internal Tag](image)
In the “Tag Properties” dialog, give the tag any name you want.

Then select a data type from the list.

The type conversion gives you the option of converting data from one format to another. When you want, for example, to observe a word tag in a double word format, WinCC performs all the necessary calculations.

Figure 2.4.6: WinCC Project “Qckstart”; Properties of a Process Tag
Specifying the Address in the PLC:

- Click on the "Select" button (it is located next to the address field) to open the "Address Properties" dialog box.
- From the list-box for the data area of the tag, select the data area "Bit Memory".
- Check if the address type "Word" and MW "0" has been set.

![Address properties dialog box]

Figure 2.4.7: WinCC Project "Qckstart"; Set Address

- Then click on "OK" to confirm.
Set a linear scaling:

Linear scaling can only be used for process tags ("external tags").

Mark the "Linear scaling" check box. This activates the input fields "Process Value Range" and "Tag Value Range".

Set the process value range (e.g. from -20 to 20) and the tag value range (e.g. from 0 to 100).

Figure 2.4.8: WinCC Project "Qckstart"; Set Linear Scaling

Note

If you want to use positive and negative numbers for your process value range, you must use a signed tag.
2.5 Editing Process Pictures

2.5.1 Step 5.1: Creating Process Pictures

In this section, we will design a process picture for our Quickstart Project - you can let your creativity free. To create a new picture and open the Graphics Designer, proceed as follows.

Creating a Process Picture

1. In the left subwindow in the WinCC Explorer, click with the right mouse button on "Graphics Designer" to display the pop-up menu.
2. In the pop-up menu, click on "New picture". Afterwards, a picture file (".pdl" = "Picture Description File") named "NewPdl0.pdl" will be created and displayed in the right subwindow in WinCC Explorer.

Figure 2.5.1: WinCC Project "Qckstart"; Creating a New Picture

1. In the right subwindow of the Control Center, click on "NewPdl0.pdl" with the right mouse button.
2. In the pop-up menu, click on "Rename picture".
3. In the next dialog box, enter "START.pdl".
Creating a Second Process Picture

Create a second picture and name it "SAMPLE.pdl". To do so, simply follow the steps given above.

Opening the Graphics Designer

To open Graphics Designer with the "START.pdl" picture, double-click on "START.pdl" in the right subwindow in WinCC Explorer.

As an alternative, you can also click on "START.pdl" with the right mouse button and then select "Open picture" in the pop-up menu.
2.5.2 The Graphics Designer

When you first open the Graphics Designer, it will look something like the following illustration.

To optimize your desktop, we recommend that the menu bar and menu palettes be arranged as shown in the illustration.

To resize the Object and Style palettes, you must first drag them into the file window while holding the left mouse button depressed. Naturally, the mouse pointer must be on the palette frame.

Move the pointer over the palette frame and make certain that it changes to a black double-arrow. With the mouse button depressed, drag the palette frame to the desired size.

Color Palette:

Assigning colors to selected objects. In addition to the 16 standard colors, you can also use custom colors that you have defined.

Object Palette

Contains the Standard Objects (Polygon, Ellipse, Rectangle, etc.), Smart Objects (OLE Control, OLE Element, I/O Fields, etc.), and Windows Objects (Button, Check Box, etc.).
Style Palette

Changes the appearance of the selected object. Depending on the type of object, you can change the type of line or border, the width of the line or border, the style of the line ends, or the fill pattern.

Alignment Palette

Permits you to change the absolute position of one or more objects, to change the position of selected objects relative to each other, or to standardize the height and width of several objects.

Zoom Palette

Sets the zoom factor (in percent) for the active window. The standard zoom factors are 8, 4, 1, 1/2, and 1/4.

Menu Bar

Contains all the menu commands for the Graphics Designer. Commands which are not currently available are displayed in gray.

Toolbar

Contains buttons to quickly perform the more common commands.

Font Palette

Permits you to change the font type, size and color in text objects, as well as the line color of standard objects.

Layer Bar

Used to select which of the 16 layers (Layer 0 to 15) will be visible. Layer 0 is selected by default.

To learn more about the displayed objects, first click on the symbol and then on the object you are interested in. For more information, please see the WinCC User Manuals.

Note

To determine, which bars or palettes will be displayed in Graphics Designer, in the menu bar, click on "View" ➔ "Toolbars". In the following "Toolbars" dialog box, mark which bars/palettes you want displayed and then confirm and close by clicking on the "OK" button.
2.5.3 The Process Picture

For our first project, we will create a tank to represent Atlanta’s water supply. All the graphic objects, which we need for our process picture, are found in the WinCC library. Beyond this, we need a button, static text and an input/output field.

Figure 2.5.3: WinCC Project “Qckstart”; The Process Picture
2.5.4  Step 5.2: Creating a Button

First, we will configure a button that enables you to switch to another picture at runtime. To create a button, which toggles between the two pictures "START.pdl" and "SAMPLE.pdl", proceed as follows:

- In the "START.pdl" picture, in the Object Palette select the "Windows Objects" button.
- In the file window, place the button with a mouse click and then resize it by dragging it with the mouse button depressed.
- Once you release the mouse button, the "Button Configuration" dialog will appear. Enter a name of your choice in the "Text" field. For example, you could enter the name of the picture you wish to jump to: "SAMPLE").
- To select the picture you wish to jump to, click on the icon next to the "Change Picture on Mouse Click" field.
- In the next dialog, double-click on the picture "SAMPLE.pdl"

![Button Configuration](image)

Figure 2.5.4: WinCC Project "Qckstart"; Button Configuration

- Close the "Button Configuration" dialog and save your picture “START.pdl” by clicking on the button.
Configure Second Button

To enable us to return during runtime from the "SAMPLE.pdl" picture to the Start Picture, we will now configure a button in the "SAMPLE.pdl" picture that switches to the "START.pdl" picture. You can open your picture by a mouse click on the icon or from the WinCC Explorer.

Note
Use the arrow-keys to move an object in small steps.
Use the Shift key and the arrow-keys to move an object in large steps.

2.5.5 Step 5.3: Configuring the Process Picture

Creating the Water Tank

- In the menu bar of the Graphics Designer, click on "View" ➔ "Library" or on the icon in the toolbar. The Object Library will be displayed with its own toolbar and object folders.
- Double-click on "Global Library" and afterwards in the right subwindow on the "PlantElements" folder.
- Double-click on the "Tanks" folder.
- To see a preview of the available tanks, click on the icon in the toolbar for the Graphics Designer's Library.

Note
The icons and in the toolbar of Graphics Designer Library enlarge or reduce the preview.

- Click on "Tank 1" and with the left mouse button depressed drag the tank into the file window.
- Using the black blocks surrounding the tank, you can resize the tank. Place the pointer over one of the black blocks and, with the left mouse button depressed, drag it until the tank is the desired size.

Creating the Pipeline

- From the "Global Library" ➔ "PlantElements" ➔ "Pipes - Smart Objekts", insert the required pipes in the picture.
- From the "Global Library" ➔ "PlantElements" ➔ "Valves - Smart Objekts", insert the required valves in the picture.
Note

It is not necessary to get an object such as a pipe bend from the library each time you need one. For one, an object can be duplicated with the commands “Copy”, “Paste”, and “Duplicate” (in the “Edit” menu or the pop-up menu). For another, the object can be adjusted to fit with the commands “Rotate” and “Mirror” in the “Arrange” menu.

Creating Static Text

- In the Object Palette, select "Standard Objects" ➔ "Static Text".
- Position the object in upper right corner of the file window and with the mouse button depressed drag it to the desired size.
- Enter the Title "Atlanta Water Supply".
- Set the font size to "20". To do so, click under the current font size ![font size icon] and select "20" from the list.
- To create a border around the text, click on the text and drag the black boxes until it is the desired size.
2.5.6 Step 5.4: Dynamise the Fill Level Display

An object is dynamised by, for example, linking one of its properties to a tag.

To display or modify the properties of an object, click with the right mouse button on the desired object.

In the pop-up menu, click on "Properties".

![Image of WinCC Project "Qckstart"; Displaying Object Properties]

**Note**

With the "Pin" icon, which is located in the toolbar of the object properties window, you can permanently fix this window in the Graphics Designer. If you now select different object, the properties of this object will be automatically shown in the window. To deactivate this function, click on the "Pin" icon once again.

In the object properties window, you can modify or set attributes. For example, you can change the colors and geometric properties (such as width and height), and set the minimum or maximum values.
Click in the left subwindow on "Tag Assignment".

In our project, the "Tank Level" tag should give (dynamise) the fill level of the tank. In the right subwindow, click with the right mouse button on the transparent lightbulb next to "Fill Level".

In the pop-up menu, select "Tag".

Figure 2.5.6: WinCC Project "Qckstart"; Connecting Tags
In the “Tags-Project” dialog window, click on the “TankLevel” tag in the tag list. Afterwards, click on the "OK" button. The transparent lightbulb will turn green.

In the column "Update Cycle (Current.)" in the row "Fill Level", click with the right mouse button on the displayed Cycle (2 sec.).

In the pop-up menu, click on the selection "2 s".

![Image](image_url)

Figure 2.5.7: WinCC Project “Qckstart”; Changing the Update Cycle
The standard settings for the minimum and maximum values for the tank bar chart are 0 and 100 respectively.

**Note**

A green lightbulb indicates that a tag is linked to this attribute. In our project, we have connected the "TankLevel" tag with the "Fill Level" attribute.

A property written in bold indicates that a tag is connected to an attribute.

---

*Figure 2.5.8: WinCC Project "Qckstart": Identifying the Dynamisation*
2.5.7 Step 5.5: Creating and Dynamising an I/O-Field

At the upper edge of the bar chart, the process picture has an input/output field. This field not only serves to display the value of a tag, but also the changes in the tag's value.

Creating an I/O-Field

To create an "I/O-Field", select in the object palette "Smart-Objects" → "I/O-Field".

Place the "I/O-Field" in the file window and then, with the mouse button depressed, drag it to the desired size. Afterwards, the "I/O-Field Configuration" dialog will appear.

To select a tag, click on the icon and, in the following dialog, select the "TankLevel" tag.

As the update cycle, select "500ms". To do so, click on the "Arrow" icon, next to the "Update" field, on the right and then click on "500ms" in the displayed list.

Figure 2.5.9: WinCC Project "Qckstart"; Configuring I/O-Fields

Afterwards, click on the "OK" button.
Note

If you have accidentally closed the I/O-Field Configuration dialog or any other object configuration dialog, before you have completed the configuration, proceed as follows:

Select the I/O-Field in the file window and, while holding the Shift-key depressed, double-click on the I/O-Field.

As an alternative, you can also click on I/O-Field with the right mouse button and then select “Configuration Dialog” in the pop-up menu.

Dynamising an I/O-Field

In the object properties window, you can modify the properties of the I/O-Field.

1. Click with the right mouse button on the “I/O-Field” you made.
2. In the pop-up menu, click on “Properties”.
3. In the left subwindow, click on the property “Limits”.
4. In the right subwindow, double-click on “Low Limit Value”.
   - In the following dialog, enter a “0”. Then click on “OK” to confirm.
5. In the right subwindow, double-click on “High Limit Value”.
   - In the following dialog, enter “100”. Then click on “OK” to confirm.

Please consider that a tag is connected with the “Output/Input” property (indicated by bold type). If you now click on the “Output/Input” property, you will see that it is connected to the “TankLevel” tag with the update cycle “500ms”. You have set these conditions in the “I/O-Field Configuration Dialog”.

Save your picture “START.pdl” by a mouse click on the icon, and minimize the Graphics Designer.
2.6 Step 6: Setting Runtime Properties

Next, we will set the Runtime Properties for our project. Among other aspects, here we determine the appearance of the runtime screen. Proceed as follows:

1. In the left subwindow of WinCC Explorer, click on the "Computer".
2. In the right subwindow of WinCC Explorer, click on the name of your computer.
3. In the pop-up menu, click on “Properties”.
4. Click on the "Graphics Runtime" tab. On this panel, you can determine the appearance of the runtime screen and set a Start Picture.
5. To select a Start Picture, click on “Search” and then, in the “Start Picture” dialog, select your picture “START.pdl”. Afterwards, click on “OK”.

Click on "OK" to close the properties window. Now you are ready to work in runtime mode!
2.7 Step 7: Activate the Project

To see how our project will look to a plant operator at runtime, click on "File" > "Activate" in the menu bar of the WinCC Explorer. A check mark will appear next to "Activate" to show that runtime is activated.

As an alternative, you can also click on the "Activate" button in the WinCC Explorer's toolbar.

---

**Note**

Click on the "Activate" button in Graphics Designer's toolbar to immediately see the changes you have made in a picture.

---

After a brief period of loading, you should see the following screen:

---

Figure 2.7: WinCC Project "Qckstart": Runtime Screen
2.8 Step 8: Using the Simulator

If no active PLC is connected to WinCC, you can use the Simulator to test your project.

To start the Simulator, click in the Windows taskbar on "Start" ➔ "SIMATIC" ➔ "WinCC" ➔ "WinCC Simulator".

**Note**
A project must be activated (at runtime) to ensure the correct operation of the simulator.

- In the simulator dialog, select the tag(s), which you wish to simulate. To do so, click on "Edit" ➔ "New Tag".
- In the "Project Tags" dialog, select the internal tag "TankLevel" and then click on "OK".
- In the "Properties" panel, click on the "Inc" type of simulation.
- Enter as start value "0" and as end value "100".
- Mark the "active" check box. In the "Tags" panel, the tags will be displayed with their modified values.

![Figure 2.8: WinCC Project "Qckstart"; Configuring the Simulator](image)

When you now switch back to your runtime screen, you will see how the simulator supplies your picture with "real" values.
3 Display Process Values

This chapter presents the basic elements of the Tag-Logging Editor and describes the process of displaying process values at runtime.

To configure Tag-Logging, proceed as follows:
1. Open the Tag-Logging Editor.
2. Configure a timer.
3. Create an archive with the Archive Wizard.
4. Create a trend window in the Graphics Designer.
5. Create a table window in the Graphics Designer.
6. Set the starting parameter.
7. Activate your project.
3.1 Step 1: Open Tag Logging

In WinCC Explorer’s left subwindow, click with the right mouse button on "Tag Logging".

In the pop-up menu, click on "Open".

Figure 3.1: WinCC Project "Qckstart"; Tag-Logging

3.2 Step 2: Timer Configuration

The timer object is located in the second line of the navigation window. Timers can be configured for logging or archiving.

Note

Logging times are the time intervals at which values are taken from the Data Manager's process image by the Tag-Logging Editor.

Archiving times are time intervals at which the data is saved in the archive. The archiving time is always a (integer) multiple of the selected logging time. The value stored at each archiving interval is always the last value logged. The first value belongs to the previous interval.

If you click on the "Timers" object, all the standard times will be shown in the data window. These standard times should NEVER be changed.
To create a new time interval, click with the right mouse button on the “Timers” object.

In the pop-up menu, click on “New”.

In the “Timers Properties” dialog, enter “weekly” as the name.

From the list, select “1 day” as the Basis.

Enter “7” as the Factor. You have now entered the following information:

1. Enter a name for the timer here.
2. Enter the Basis for the timer.
3. Enter the Factor for the timer.

The time intervals for logging or archiving are derived by multiplying the Basis by the Factor.

Confirm your entries by clicking on "OK".

Figure 3.2: WinCC Project "Qckstart"; Set Times
3.3 Step 3: Creating an Archive

The archive wizard offers an automatic and simple way to create an archive.

To create an archive, in the navigation window, click with the right mouse button on "Archive".

In the pop-up menu, click on "Archive Wizard ...".

In the first dialog box, click on the "Next" button.

Enter "TankLevel_Archive" in the field labeled "Archive name".

For the Archive Type select "Process Value Archive".

Figure 3.3.1: WinCC Project "Qckstart"; Archive Wizard - Configuring the Archive
Click on "Next".

Click on the "Select" button and in the next dialog select the "TankLevel" tag. Click on "OK" to confirm your entries.

Click on the "Apply" button to exit the Archive Wizard.

Figure 3.3.2: WinCC Project "Qckstart"; Archive Wizard - Tag Selection
To change the properties of the archive tags selected in the table window, click the right mouse button in the table window. If no tag is selected, this command will automatically select the first tag in the table window.

In the pop-up menu, click on "Properties".

Change the name of the archive tag to 7 "TankLevel_Arch".

Select the "Parameter" tab.

For the range of "Cycle"s, enter the following values: Logging = 1 second; Archiving = 1 * 1 second

Confirm your entries by clicking on "OK".

This completes the configuration of the Process Value Archive. The "TankLevel" tag will be logged once every second and archived as the "TankLevel_Arch" tag.

Click on the button save your configuration - so that these settings will be used the next time the runtime mode is activated.

Close the Tag-Logging Editor.
3.4 Step 4: Creating a Trend Window

A trend window makes it possible to display process tags in the form of a graph. In WinCC Explorer, create a new picture "TagLogging.pdl" and open this in the Graphics Designer.

1. In the Object Palette, select the "Controls" tab and then the "WinCC Online Trend Control".

2. Place the control in the file window with a mouse click and then drag it with the mouse button depressed to the desired size.

3. In the quick configuration dialog on the "General" panel, enter "Fill Level_Curves" as the title of the trend window.

![Properties of WinCC Online Trend Control](image)

*Figure 3.4.1: WinCC Project "Qckstart"; General Properties of Trend Control*
Click on the "Curves" tab.

Enter "TankLevel" as the name of the curve.

Click on the Selection button.

On the left side of the Archive/Tag Selection dialog, double-click on the archive "TankLevel_Archive".

On the right side of the Archive/Tag Selection dialog, click on the "TankLevel_Arch" tag.

Figure 3.4.2: WinCC Project "Qckstart"; Properties of the Curve
Click on "OK" to confirm your entries.

With the "CRTL"-key depressed double-click on the control to see a preview of the trend window at runtime.

![Image](image.png)

Figure 3.4.3: WinCC Project "Qckstart"; Previewing the Trend Window

---

**Note**

To return to the normal view, click with the left mouse button outside the controls on the Graphics Designer's file window.

---

### 3.5 Step 5: Creating a Table Window

With a table window, you can display the process tags in the form of a table.

- In Object Palette, select the “Controls” tab and then “WinCC Online Table Control”.

- Place the control in the file window with a mouse click and, with the mouse button depressed, drag it to the desired size.

- In the quick configuration dialog under the “General” tab, enter “TankLevel_Tables” as the title for the trend window.
Activate the "Column" tab

Enter "TankLevel" as the name for the column.

Click on the "Selection" button.

Double-click in the left portion of the Archive/Tag Selection dialog on the "TankLevel_Archive" archive.

In the right portion of the Archive/Tag Selection, click on the "TankLevel_Arch" tag.

Click on "OK" to confirm your entry.
Figure 3.5.2: WinCC Project "Qckstart"; Properties of the Table

- Click on "OK" to confirm your entries.
- With the "CTRL"-key depressed double-click on the control to see a preview of the trend window at runtime.

Figure 3.5.3: WinCC Project "Qckstart"; Preview of the Table Window

**Note:**

To return from the preview to the normal mode, click with the left mouse button outside the control in Graphics Designer file window.

- Save your picture "TagLogging.pdl" with a mouse click on the icon, and minimize the Graphics Designer.
3.6 Step 6: Setting Runtime Properties

Next we will set the runtime properties so that tag logging will also be started at runtime.

1. In the left subwindow of WinCC Explorer, click on the "Computer".

2. In the right subwindow of WinCC Explorer, click on the name of your computer.

3. In the pop-up menu, click on "Properties".

4. Click on the "Startup" tab.

5. Mark the "Tag Logging Runtime" check box.

![Computer properties](image)

Figure 3.6: WinCC Project "Qckstart"; Setting Runtime Properties

6. Click on the "Graphics Runtime" tab.

7. To select a start picture, click on "Search" and, in the "Start Picture" dialog, select your picture "TagLogging.pdl".

8. Click on "OK" to confirm your entries.
3.7 Step 7: Activating the Project

To see how the trend window will look at runtime, click on the "Activate" button in WinCC Explorer's toolbar.

To activate the Simulator, click in the Windows taskbar on "Start" → "SIMATIC" → "WinCC" → "WinCC Simulator".

As the tag to be simulated, select the internal tag "TankLevel" and then click on "OK".

In "Properties" panel, click on the "Inc" type of simulation.

Enter "0" as the start value and "10" as the end value.

Mark the "active" check box. In the "Tags" panel, the tags will then be shown with their respective new values.

Now the simulated course of the "TankLevel" tag will be displayed in the trend window and table window.

Figure 3.7: WinCC Project "Qckstart"; Trend Window at Runtime
4 Configuring Messages

This chapter presents the basic elements of the Alarm Logging Editor and describes the creation of a message system for runtime.

To configure Alarm Logging, please proceed as follows:
1. Open the Alarm Logging Editor.
2. Start the System Wizard.
3. Configure the message text.
4. Using message class types, set the color of the message.
5. Configure the monitoring of limit values.
6. Insert a message window in your picture.
7. Set the starting parameter.
8. Activate your project.
4.1 Step 1: Opening Alarm Logging

In WinCC Explorer’s left subwindow, click with the right mouse button on “Alarm Logging”.

In the pop-up menu, click on “Open”.

Figure 4.1: WinCC Project "Qckstart": Alarm Logging
4.2 Step 2: Starting the System Wizard

The System Wizard offers an automatic and simple way to create an alarm system.

To activate the System Wizard, click on "File" ➔ "Select Wizard...". Or, in the toolbar for Alarm Logging, click on the button.

In the "Select Wizard..." dialog, double-click on the System Wizard.

In the first dialog box, click on the "Next" button.

In the dialog box, select "System Wizard: Select Message Blocks" the System Blocks "Date, Time, Number" and the User Text Blocks "Message text, point of error".

![Figure 4.2.1: WinCC Project "Qckstart", System Wizard - Selecting Message Blocks]

Click on "Next".

In the dialog box, select "System Wizard: Preset Classes" the settings "Class of Error with Types Alarm, Error and Warning (Incoming Acknowledgement)".

---

WinCC Manual
C79000-G8276-C161-02
Click on "Next".

In the dialog box, select "System Wizard: Select Archive" the setting "Short-Term Archive for 250 Messages".

Click on "Next".

The last dialog of the System Wizard provides a summary of the elements to be created by the wizard.

Click on "Apply".
4.3 Step 3: Message Text Configuration

Next, we will configure the messages in the table window. For our project, we will set three messages. But first the length of the User Text Blocks created by the Wizard must be adjusted.

Changing the Length of the "Message Text" User Text Block

1. In the navigation window, click on the icon in front of "Message Blocks".
2. In the navigation window, click on "User Text Blocks".
3. In the data window, click with the right mouse button on "Message text".
4. In the pop-up menu, click on "Properties".
5. In the next dialog, enter the value "30".

Changing the Length of the "Point of error" User Text Block

1. In the navigation window, click on "Message Blocks" → "User Text Blocks".
2. In the data window, click with the right mouse button on "Point of error".
3. In the pop-up menu, click on "Properties".
4. In the next dialog, enter the value "25".

Configuring the First Message

1. In Line 1, double-click on the "MessageTag" field.
2. In the next dialog, select the "TankLevel" tag and then click on "OK".
3. In Line 1, double-click on the "MessageBit" field.
4. Enter the value "2". This number indicates that the message in Line 1 will be triggered when the third bit from the right of the 16 Bit "TankLevel" tag is set.
5. In Line 1, double-click on the "Message text" field.
6. In the next dialog, enter the text "Fill level exceeded".
7. In Line 1, double-click on the "Point of error" field.
8. In the next dialog, enter the text "Tank".
Configuring the Second Message

Configure the Second Message with the right mouse button, click on the number "1" in first column of the table window.

- In the pop-up menu, click on "Append New Line"
- In Line 2, double-click on the "MessageTag" field.
- In the next dialog, select the "TankLevel" tag and then click on "OK".
- In Line 2, double-click on the "MessageBit" field.
- Enter the value "3". This number indicates that the message in Line 1 will be triggered when the fourth bit from the right of the 16 Bit "TankLevel" tag is set.
- In Line 2, double-click on the "Message text" field.
- In the next dialog, enter the text "Tank empty".
- In Line 2, double-click on the "Point of error" field.
- In the next dialog, enter the text "Tank".

Configuring the Third Message

Configure the Third Message with the right mouse button, click on the number "2" in first column of the table window.

- In the pop-up menu, click on "Append New Line"
- In Line 3, double-click on the "MessageTag" field.
- In the next dialog, select the "TankLevel" tag and then click on "OK".
- In Line 3, double-click on the "MessageBit" field.
- Enter the value "4". This number indicates that the message in Line 1 will be triggered when the fifth bit from the right of the 16 Bit "TankLevel" tag is set.
- In Line 3, double-click on the "Message text" field.
- In the next dialog, enter the text "Pump failed".
- In Line 3, double-click on the "Point of error" field.
- In the next dialog, enter the text "Pump".
Note

Instead of editing each text individually as we described above, you can also edit the message texts in the "Single message" dialog. To open this dialog, select "Properties" in the pop-up menu for a message.

Figure 4.3: WinCC Project "Qckstart": Configuring Message Text
4.4 Step 4: Configuring Message Colors

Messages can be shown in different colors at runtime. This makes it easy to quickly identify the message based on its color.

- In the navigation window, click on the icon in front of "Message classes".
- Click on the message class "Error".
- In the data window, click with the right mouse button on "Alarm".
- In the pop-up menu, click on "Properties".

![Image](image_url)

Figure 4.4.1: WinCC Project "Qckstart"; Configuring Message Colors

In the next dialog, you can set the color of the message text and backgrounds depending on the state of the message.

Configure these colors for your messages in the "Alarm" message class:

- Click in the preview area on "Came In" (alarm is active).
- Click on the "Text Color" button.
- In the color selection dialog, select "White".
- Click on the "Background Color" button.
- In the color selection dialog, select "Red".
Click in the preview area on "Went Out" (alarm is deactivated).
Click on the "Text Color" button.
In the color selection dialog, select "Black".
Click on the "Background Color" button.
In the color selection dialog, select "Yellow".

Click in the preview area on "Acknowledged" (alarm is acknowledged).
Click on the "Text Color" button.
In the color selection dialog, select "White".
Click on the "Background Color" button.
In the color selection dialog, select "Blue".

Figure 4.4.2: WinCC Project "Qckstart"; Assigning Message Colors

Click on "OK" to confirm your entries.
4.5 Monitoring of Limit Values

4.5.1 Step 5.1: Configuring the Monitoring of Limit Values

With limit value monitoring, tags can be monitored to ensure that their values stay within the assigned limits.

1. In the Alarm Logging editor’s menu bar, click on "Tools" → "Add Ins ...".

2. In the "Add Ins" dialog, which is shown next, activate the "Limit Value Monitoring" component.

Figure 4.5.1: WinCC Project "Qckstart"; Monitoring Limit Values
The limit value monitoring is displayed in the navigation window below the Message Classes.

In the data window, click with the right mouse button on "Limit Value Monitoring".

In the pop-up menu, click on "New".

Figure 4.5.2: WinCC Project "Qckstart"; Monitoring Limit Values
In the "Properties" dialog, you can set the tags which should be monitored and the type of monitoring.

To select a tag, click in the dialog on the button.

![Figure 4.5.3: WinCC Project "Qckstart"; Configuring Limit Value Monitoring]

**Note**

If you mark the "one message for all limit values" check box, the same message will be displayed at runtime regardless of whether the high or low limit is exceeded (you must then enter a message number).

You can set the delay in the delay time field. An alarm message will first be displayed after the delay time has elapsed (this prevents displaying messages for cases where the limit is exceeded for a very short time).
In the “Select a Tag” dialog that is shown next, select an available tag or create a new tag. For our project, we will create a new tag.

1. To create a tag, click on the button.
2. In the “Tag properties” dialog, enter “AnalogAlarm” as the name of the new tag.
3. In the “Tag properties” dialog, select the data type “Unsigned 16-bit value”.
4. Click on “OK” to confirm your entries.
5. On the left side of the tag selection dialog, click on “Internal tags”.
6. On the right side of the tag selection dialog, click on “AnalogAlarm”.

Click on “OK” to confirm your entries.

Click on “OK” to close the “Properties” dialog.

Figure 4.5.4: WinCC Project “Qckstart”; Configuring Limit Value Monitoring - Selecting Tags
4.5.2 Step 5.2: Setting Limit Values

Setting the upper limit value

1. Click with the right mouse button on the "AnalogAlarm" tag you made.
2. In the pop-up menu, click on "New".

In the "Properties" dialog, activate the "High Limit" point.

As limit, enter the value "90".

Under Hysteresis, activate the point "effective for both".

Enter a "4" for the message number.

Note

Hysteresis values can be entered as either absolute values or in percentages (of the high or low limit value).
Figure 4.5.6: WinCC Project "Qckstart": Configuring the High Limit

- #1 Select “Upper Limit”.
- #2 For the limit value, enter "90".
- #3 Select “effective for both”.
- #4 Enter "4" as message number.

Click on "OK" to confirm your entries.
Setting the lower limit value

- Click with the right mouse button on the "AnalogAlarm" tag you made.
- In the pop-up menu, click on "New".
- In the "Properties" dialog, activate the "Low Limit" point.
- As limit, enter the value "10".
- Under Hysteresis, activate the point "effective for both".
- Enter a "5" for the message number.

WinCC will automatically generate the associated messages 4 and 5.

![Image showing WinCC Project "Qckstart": Generating Message Lines](image)

Figure 4.5.7: WinCC Project "Qckstart": Generating Message Lines

- Click on the ![button](image) to save your configuration.

Close the "Alarm Logging" editor.
4.6 Step 6: Creating a Message Picture

Configuring a Message Window

To insert a message window in a picture, proceed in a manner similar to that described above for inserting a curve or table display.

Open the Graphics Designer and create a new picture named "AlarmLogging.pdl". Afterwards, follow these steps:

1. In the Object Palette, select the "Controls" tab and then the "WinCC Alarm Control".

2. Place the control in the file window with a mouse click and then drag it with the mouse button depressed to the desired size.

3. In the quick configuration dialog on the panel, enter "Water Supply Atlanta" as the title of the message window.

4. Mark the "Display" check box.

Click on "OK" to confirm your entries.

Figure 4.6.1: WinCC Project "Qckstart"; WinCC Alarm Control - Quick Configuration
I/O Field Configuration

- In the Object Palette, select "Standard" ➔ "Smart Objects" ➔ "I/O Field".

- In the file window, place the button with a mouse click and then resize it by dragging it with the mouse button depressed.

- In the "I/O Field Configuration" dialog, click on the tag that should be connected to the I/O Field.

- In the "Update" field, select an update cycle of 500 ms.

Figure 4.6.2: WinCC Project "Qckstart"; Dynamising an I/O Field

- Click on "OK" to confirm your entries.
Create a Slider

1. In the Object Palette, select "Standard" ➔ "Windows Objects" ➔ "Slider Object".

2. In the file window, place the button with a mouse click and then resize it by dragging it with the mouse button depressed.

3. In the "I/O Field Configuration" dialog, click on the button to select the tag that should be connected to the I/O Field.

4. In the "Update" field, select an update cycle of 500 ms.

---

**Figure 4.6.3: WinCC Project "Qckstart"; Dynamising a Slider**

1. Click on this button to select the "AnalogAlarm" tag.

2. Select an update cycle of 500 ms here.

3. Select the orientation of the slider here.

---

Click on "OK" to confirm your entries.

Save your picture "AlarmLogging.pdl" with a mouse click on the icon, and minimize the Graphics Designer.
4.7 Step 7: Setting Runtime Properties

Next we will set the runtime properties so that alarm logging will also be started at runtime.

1. In the left subwindow of WinCC Explorer, click on the "Computer".
2. In the right subwindow of WinCC Explorer, click on the name of your computer.
3. In the pop-up menu, click on "Properties".
4. Click on the "Startup" tab.
5. Mark the "Alarm Logging Runtime" check box. This also automatically activates the "Text Library Runtime".

![Computer properties](image)

Figure 4.7: WinCC Project "Qckstart"; Setting Runtime Properties

6. Click on the "Graphics Runtime" tab.

7. To select a start picture, click on "Search" and, in the "Start Picture" dialog, select your picture "AlarmLogging.pdl".
8. Click on "OK" to confirm your entries.
4.8 Step 8: Activating the Project

To see how the message window will look at runtime, click on the "Activate" button in WinCC Explorer's toolbar.

![Image of WinCC Project "Quickstart" Message Window at Runtime]

At runtime, you can view a list of the current messages by clicking on the "Message list" button in the Message window toolbar.

To acknowledge a single message, click on the "Single acknowledgement" button in the toolbar.

Group messages are acknowledged with the "Group acknowledgement" button.

To view a list of the last 250 archived messages, click on the "Short-Term Archive" button.
5 Printing the Message Sequence Report

This chapter presents the basic elements of the Report Designer und and describes the creation of a message sequence report with the aid of a template. This section also covers the assignment of a print job.

To print a message sequence report, please proceed as follows:

1. Activate the message sequence report in the Alarm Logging Editor.
2. Define the layout of the message sequence report.
3. Set the print job parameters.
4. Set the starting parameter.
5. Activate the project: Preview and Print the Report.
5.1 Step 1: Activate the Message Sequence Report

1. In WinCC Explorer's left subwindow, click with the right mouse button on "Alarm Logging".
2. In the pop-up menu, click on "Open".
3. In the navigation window of the Alarm Logging editor, click with the right mouse button on "Reports".
4. In the pop-up menu, click on "Add/Remove..."
5. In the "Assigning Report Parameters" dialog, mark the "Message sequence report active" check box.

![Assigning Report Parameters dialog]

Then click on "OK" to confirm.
Close the "Alarm Logging" editor.
5.2 Editing the Layout

5.2.1 Step 2.1: Open Layout

The layout used in a print job is defined in the Report Designer. The Report Designer opens automatically when you open a layout.

In the left subwindow in the WinCC Explorer, click with the left mouse button on the icon in front of "Report Designer".

In the left subwindow of WinCC Explorer, click with the left mouse button on "Layout".

In the right subwindow of WinCC Explorer, click with the right mouse button on the layout "@alrtmef.rpl".

In the pop-up menu, click on "Open layout".

Figure 5.2.1: WinCC Project "Qckstart"; Opening a Layout
5.2.2 The Report Designer

When you open the Report Designer, it will look similar to the following illustration.

![Report Designer Illustration](image)

*Figure 5.2.2: WinCC Projekt "Qckstart": The Report Designer*

To optimize your file window, we recommend that the menu bar and menu palettes be arranged as shown in the illustration.

- **To resize the Object and Style palettes**, you must first drag them into the file window while holding the left mouse button depressed. Naturally, the mouse pointer must be on the palette frame.
- **Move the pointer over the palette frame and make certain that it changes to a black double-arrow.** With the mouse button depressed, drag the palette frame to the desired size.

**Color Palette:**

Assigning color to the selected object(s). In addition to the 16 standard colors, you can also use any custom colors that you have defined.
Object Palette

Contains the Standard Objects (Polygon, Ellipse, Rectangle, etc.), Dynamic Objects (Dynamic Text, Dynamic Tables, etc.), and System Objects (Date, Page Number, etc.).

Style Palette

Changes the appearance of the selected object. Depending on the object, you can change the type of line or border, the width of the line, or the fill pattern.

Alignment Palette

Permits you to change the absolute position of one or more objects, to change the position of selected objects relative to each other, or to standardize the height and width of several objects.

Zoom Palette

Sets the zoom factor (in percent) for the active window. You can set the various standard zoom factors via the buttons.

Menu Bar

Contains all the menu commands for the Report Designer. Commands which are not currently available are displayed in gray.

Toolbar

Contains buttons to quickly perform the more common commands.

Font Palette

Permits you to change the font type, size and color in text objects, as well as the line color of standard objects.

To learn more about the displayed objects, first click on the symbol and then on the object you are interested in. For more information, please see the WinCC User Manuals.

Note

To determine, which bars or palettes will be displayed in Report Designer, in the menu bar, click on “View” ➔ “Toolbars”. In the following “Toolbars” dialog box, mark which bars and palettes you want displayed and then confirm and close by clicking on the “OK” button.
5.2.3  Step 2.2: Editing the Layout

The layout used in a print job is defined in the Report Designer. The Report Designer opens automatically when you open a layout.

In the layout for a message sequence report, click with the right mouse button on the table.

In the pop-up menu, click on "Properties".
Click on the "Connect" tab.

Click on the "Connect..." button.

Make certain that, under "Alarm Logging Runtime", "Message Sequence Report" is selected. Afterwards, click on "OK".

Figure 5.2.4: WinCC Project "Qckstart"; Connecting a Dynamic Table
In the right subwindow of the "Connect" panel, click on "Selection".

Click on the "Edit..." button.

Make certain that all the message blocks, which should be printed in the message sequence reports, are found in the "Current Column Order" field. Afterwards, click on "OK".

Figure 5.2.5: WinCC Project "Qckstart"; Selecting the Message Blocks

**Note**

With the buttons, you can transfer message blocks from the list of "Available Message Blocks" to the "Current Column Order" list of blocks to be printed.

With the and buttons, you can change the order in which the message blocks will be printed.
In the "Object Properties" dialog, click on the "Properties" tab.

Click on the symbol to fix the dialog.

To edit the properties of the layout, click with the left mouse button on an empty area in the layout outside of the table.

In the left subwindow, click on "Geometry" and then check that the proper paper size is selected in the right subwindow.

If this is not the case, double-click in the right subwindow on "Paper Size".

In the Paper Size dialog select the proper size and then click on "OK".

Save your layout by clicking on the symbol.

Close the Report Designer editor.
5.3 Step 3: Setting the Print Job Parameters

To print a report during runtime, you must first set the print job parameters in WinCC Explorer.

In the left subwindow of WinCC Explorer, click on "Print job". A list of prepared print jobs will then be displayed on the right.

To create a print job, please proceed as follows:

- In WinCC Explorer’s left subwindow, click with the right mouse button on "Print job".
- In the pop-up menu, click on "New print job". Your print job will be assigned the name "Print job 001" and placed at the end of the list of print jobs.
- In the right subwindow of WinCC Explorer, click with the right mouse button on the entry for the just created "Print job 001".
- In the pop-up menu, click on "Properties".
- Name the print job "Message Sequence Report".
- In the list, select "@alrtmef.rpl" to be used for the layout.
- Mark the "Start time" check box.

![Figure 5.3: WinCC Projekt "Qckstart"; Setting Print Job Properties](image-url)
Click on the tab for the "Set Printer" panel.
Select your printer from the list.
Click on "OK" to confirm your entries.

5.4 Step 4: Setting Runtime Properties

Next we will set the runtime properties so that the Report Designer is also started at runtime.

- In the left subwindow of WinCC Explorer, click on the "Computer".
- In the right subwindow of WinCC Explorer, click on the name of your computer.
- In the pop-up menu, click on "Properties".
- Click on the "Startup" tab.
- Mark the "Report Runtime" check box.

![Computer properties window](image)

Figure 5.4: WinCC Project "Qckstart"; Setting Runtime Properties

Click on "OK" to confirm your entries.
5.5 Step 5: Activating the Project

To enable printing the message sequence report at runtime, click on the "Activate" button in the WinCC Explorer toolbar.

In the Windows Taskbar, click on WinCC Explorer.

Click with the right mouse button on the "Message Sequence Report" print job.

In the pop-up menu, click on "Preview print job".

In the preview, you can change the display with the "Zoom In", "Zoom Out" or "Two Pages".

To print a print job, click on the "Printing" button.
6 Printing a Tag Logging Runtime Report

This chapter shows you how to create a report with the Tag Logging Runtime data.

To create a Tag Logging Runtime Report, please proceed as follows:

1. Create a new layout.
2. Edit the layout of the Tag Logging Runtime Report.
3. Set the print job parameters.
6.1 Step 1: Creating a Layout

In the left subwindow of WinCC Explorer, click with the right mouse button on "Layout".

In the pop-up menu, click on "New Layout".

![Image of WinCC Explorer with highlighted steps]

Figure 6.1: WinCC Project "Qckstart"; Creating a New Layout

A new layout named "NewRPL00.RPL" will be added to the end of the list in the right subwindow of WinCC Explorer.

To rename the layout, click with the right mouse button on "NewRPL00.RPL".

In the pop-up menu, click on "Rename layout".

In the next dialog rename the layout to "TagLogging.rpl".
6.2 Editing the Layout

6.2.1 Step 2.1: Editing the Static Portion

In the right subwindow of the WinCC Explorer, double-click on the layout "TagLogging.rpl".

The Report Designer will open showing an empty page. In creating a layout, you are not bound to a predefined sequence.

We will first insert the static elements - with the Date / Time, Page number, Layout names, and Project names.

Begin editing the static elements of the layout by clicking on the button in the toolbar.

To display the date and time in the layout, click in the Object Palette on "System Objects" ➔ "Date/Time".

Position the object in lower left corner and, with the mouse button depressed, drag it to the desired size.

Then click with the right mouse button on the "Date/Time" object.

In the pop-up menu, click on "Properties".

Make certain that you are in the "Properties" panel. In the left subwindow, click on "Font".

In the right subwindow, double-click on "X Alignment" and select "Left".

In the right subwindow, double-click on "Y Alignment" and select "Centered".

Following the example above, insert the system object "Project name". With regards to the alignment, make the same changes as we did with the "Date/Time" object.

Now insert the system objects "Page Number" and "Layout Name" in the lower right corner. Change the "X Alignment" to "Right" and the "Y Alignment" to "Centered".
6.2.2  Step 2.2: Editing the Dynamic Portion

To edit the dynamic portion of the layout, click on the icon in the toolbar.

To display process values in a table, click in the Object Palette on “Dynamic Objects” – “Dynamic Table”.

Position the table in your layout and with the mouse button depressed, drag it to the desired size.

In the “Connect” dialog, click with the left mouse button on the icon in front of the entry “Tag Logging Runtime”.

Select the entry “Tag Table”.

![Figure 6.2.1: WinCC Project “Qckstart”; Connecting a Dynamic Table](image-url)
Click on "OK" to confirm your entries.

Click with the right mouse button on the table.

In the pop-up menu, click on "Properties".

Click on the "Connect" tab.

In the right subwindow of the "Connect" panel, click on "Tag Selection" and then on the "Edit" button.

In the "Tag Logging Runtime" dialog, click on: the "Add..." button in "Tag Selection for Logging".

In the left subwindow of the "Archive Selection" dialog, click on the icon in front of "Qckstart".

In the left subwindow, select the "TankLevel_Archiv" archive.

In the right subwindow, select the "TankLevel_Arch" tag.

Figure 6.2.2: WinCC Project "Qckstart": Connect Tag
Click on "OK" to confirm your entries.
Click on "OK" to confirm your entries.
Click on the "Properties" tab.
Click on the ‹icon.

To edit the properties of the layout, click with the right mouse button on an empty area in the layout outside of the table.

In the left subwindow, click on "Geometry" and then check that the proper paper size is selected in the right subwindow.

If this is not the case, double-click in the right subwindow on "Paper Size".

In the Paper Size dialog, select the proper paper size and then click on "OK".

Save your layout by clicking on the ‹symbol.

Close the Report Designer editor.
6.3 Step 3: Setting the Print Job Parameters

To print the message sequence report during runtime, you must first set the print job parameters in WinCC Explorer.

1. In WinCC Explorer’s left subwindow, click with the right mouse button on “Print job”.

2. In the right subwindow of WinCC Explorer, click with the right mouse button on the print job “Report Tag Logging RT Tables”.

3. In the pop-up menu, click on “Properties”.

4. In the list, select “TagLogging.rpl” to be used for the layout.

5. Mark the “Start time” check box.

![Print Job Properties](image)

*Figure 6.3: WinCC Projekt “Qckstart”; Setting Print Job Properties*

6. Click on the tab for the “Set Printer” panel.
7. Select your printer from the list.
8. Click on “OK” to confirm your entries.
6.4 Step 4: Activating the Project

To enable printing the report at runtime, click on the "Activate" button in the WinCC Explorer toolbar.

In the Windows Taskbar, click on WinCC Explorer.

With the right mouse button, click on the print job "@Report Tag Logging RT Tables".

In the pop-up menu, click on "Preview print job".

In the preview, you can change the display with the "Zoom In", "Zoom Out" or "Two Pages".

To print a print job, click on the "Printing" button.
7  Client/Server Operation

In this chapter, we will connect a client to our single-user system and activate the project's runtime.

To connect a client to your server, please proceed as follows:

1. Change your project from a single-user to a multi-user system.
2. Include the client computer in your project.
3. Set the client parameters.
4. Open the project on the client.
5. Different runtime screens on the server and the client.
6. Activate your project.
7.1 Client/Server Systems

A client/server system consists of one or more clients and a server. The clients and server are connected to each other by a network. Clients send specific requests to the server, which then performs them. The clients and server have a relationship based on commands.

The Hardware and Operating System Prerequisites for Client/Server Systems

The operating system for the clients and server must be Windows NT 4.0 with at least Service Pack 5 installed.

The clients and server must be connected in a LAN (Local Area Network) running the TCP/IP protocol. Furthermore, the clients must be authorized to access the server in order to open project files.
7.2  Step 1: Creating a Multi-User System

Our project was created as a single-user system. Nonetheless, it can be converted to a multi-user system at any time. Multi-user systems can also be converted to a single-user system whenever you want.

In the left subwindow of WinCC Explorer, click with the right mouse button on the entry "Quickstart".

In the pop-up menu, click on "Properties".

In the list, select "Multi-User System" to be used for the layout.

**Note**

After the project type has been changed, you must quit WinCC and start it again!
7.3  Step 2: Connecting a Client

In the left subwindow of WinCC Explorer, click with the right mouse button on the entry "Computer".

In the pop-up menu, click on "New Computer ...".

In the field "Computer Name", enter the name of the client computer (the NetBIOS name).

Click on "OK" to confirm your entries.

![Image of WinCC Explorer window with instructions and figure 7.2.1: WinCC Project "Qckstart"; Add Client]

Figure 7.2.1: WinCC Project "Qckstart"; Add Client
Now both computers - Server and Client - will be show in WinCC Explorer.

![WinCC Explorer](image)

### 7.4 Step 3: Setting the Client’s Runtime Properties

**The Client’s Starting Parameter**

1. In the right subwindow of WinCC Explorer, click with the right mouse button on the entry for the client.
2. In the pop-up menu, click on "Properties".
3. Click on the "Startup" tab.
4. Mark the “Alarm Logging Runtime” check box (this will automatically select the “Text Library Runtime”), “Tag Logging Runtime”, “Graphics Runtime”, and, if you want to print reports, the “Report Runtime”.

![Client's Start Parameter](image)
Setting the Graphics Runtime Properties of the Client

- Click on the "Graphics Runtime" tab.
- To select a start picture, click on "Browse" and, in the "Start Picture" dialog, select your picture "AlarmLogging.pdl".
- Under "Window Attributes", mark the "Title", "Maximize", and "Minimize" check boxes.

\[\text{Figure 7.3.2: WinCC Project "Qckstart"; The Client's Graphics Runtime Properties}\]

- Click on "OK" to confirm your entries.
7.5 Step 4: Opening a Project on the Client

To open the "Qckstart" project on a client, please proceed as follows:

- Start WinCC on the client computer.

**Note**
If WinCC loads a project when it starts, then click on "Open..." in the "File" menu in WinCC Explorer.

- In the dialog, select the option "Open an Available Project".

On the client, go through the file selection dialog for the "Network Neighborhood" to the directory for the "Qckstart" project on the server. In this directory, find "Qckstart.MCP" and double-click on it to open the project.

- Click on "OK" to confirm your entries.
7.6 Step 5: Different Start Pictures on the Client and Server

To display the "TagLogging.pdl" picture on the server and the "AlarmLogging.pdl" picture on the client, proceed as follows. You can make the changes on either the client or the server.

\[R\] In the right subwindow of WinCC Explorer, click with the right mouse button on the entry for the server.

\[\] In the pop-up menu, click on "Properties".

\[\] Click on the "Graphics Runtime" tab.

\[\] Click on "Search" and, in the "Start Picture" dialog, select the picture "TagLogging.pdl".

\[R\] In the right subwindow of WinCC Explorer, click with the right mouse button on the entry for the client.

\[\] In the pop-up menu, click on "Properties".

\[\] Click on the "Graphics Runtime" tab.

\[\] Click on "Search" and, in the "Start Picture" dialog, select the picture "AlarmLogging.pdl".
7.7 Step 6: Activating the Project

If you have already activated your project on the server, it has also been automatically activated on the client computer. Otherwise, you can activate your project from every client or server.

- In the WinCC Explorer toolbar, click on the "Activate" button.

**Note**
Activating a project on a client or server activates it on all the client-server system’s connected computers.

If you deactivate a project on a client computer, by clicking on the "Deactivate" button in the WinCC Explorer toolbar, you will be asked whether you wish to deactivate the project on just this client or on all the computers.

- To activate the Simulator, click in the Windows taskbar on "Start" ➔ "SIMATIC" ➔ "WinCC" ➔ "WinCC Simulator".
- As the tag to be simulated, select the internal tag "TankLevel" and then click on "OK".
- In "Properties" panel, click on the "Inc" type of simulation.
- Enter as start value "0" and as end value "100".
- Mark the "active" check box. In the "Tags" panel, the tags will be displayed with their modified values.
This completes your first WinCC project. We wish you much success in the future with WinCC!
Index

A
Activate ..................................................... 40
Activate the Message Sequence Report ... 80
Add communication driver .................. 14
Add PLC Driver ......................................... 14
Alarm Control ........................................... 73
Alarm Logging ........................................... 57, 58
Opening Alarm Logging .................... 58
Authorization .............................................. 7
Installation ................................................ 7

C
Client/Server System ............................. 100
Configure User Text Block ................. 61
Configuration of Archiving times .......... 44
Configuration of Logging times .......... 44
Configuring a Message Window ........... 73
Configuring a Slider ......................... 73
Configuring Message Colors ............. 64
Configuring Messages ..................... 57
Connect Dynamic Tables ................. 84, 94
Connecting a Client ............................... 102
Creating a Button ................................. 30
Creating a Client/Server Project ......... 99
Creating a Page Layout ....................... 92
Creating an Alarm System ................. 59
Creating an Archive ......................... 46
Creating Internal Tags ..................... 17
Creating Process Tags ..................... 21
Creating Project ................................. 12
Creating Static Text ............................. 31

D
Database .................................................. 10
  Connection to the database............... 10
  Startup of the Database .................. 10
Deinstallation ..................................... 9
Dynamise .............................................. 33
Dynamising the Fill Level Display ....... 33

E
Edit Layout ............................................. 84
Edit Page Layout ................................ 84

F
fix object properties .............................. 33

G
Graphics Designer ................................. 27
  Alignment Palette ............................... 27
  Color Palette ...................................... 27
  Font Palette ...................................... 27
  Layer Bar .......................................... 27
  Menu Bar .......................................... 27
  Object Palette ................................... 27
  open ................................................. 25
  Style Palette .................................... 27
  Toolbar ............................................. 27
  Viewing Toolbars ................................ 27
  Zoom Palette .................................... 27

H
Hardware .................................................. 1
  Prerequisites ....................................... 1

I
I/O-Field .................................................. 37
  Configuring an I/O-Field ................... 73
  Creating an I/O-Field ........................... 37
  Dynamising an I/O-Field .................... 37
Installation .......................................... 2
  Authorization ...................................... 7
  Select components ............................. 5
  Select language ................................... 4
  Tag Simulator .................................... 8
  User Registration ................................ 3

L
Layout ...................................................... 81, 92
  Creating a Layout ................................ 92
  Dynamic Portion ................................ 94
  Open Layout .................................... 81
  Static Portion .................................... 93
# Index

<table>
<thead>
<tr>
<th>M</th>
<th>R</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Archives .................................... 59</td>
<td>Report Designer ........................................ 82</td>
</tr>
<tr>
<td>Long-Term Archive .................................. 59</td>
<td>Alignment Palette ...................................... 82</td>
</tr>
<tr>
<td>Short-Term Archive .................................. 59</td>
<td>Color Palette .......................................... 82</td>
</tr>
<tr>
<td>Message Block ......................................... 59</td>
<td>Font Palette ........................................... 82</td>
</tr>
<tr>
<td>Message class ......................................... 59</td>
<td>Menu Bar ............................................... 82</td>
</tr>
<tr>
<td>Monitoring of Limit Values ........................ 66</td>
<td>Object Palette ......................................... 82</td>
</tr>
<tr>
<td>Monitoring of Limit Values ........................ 66</td>
<td>Style Palette .......................................... 82</td>
</tr>
<tr>
<td>Setting Limit Values .................................. 70</td>
<td>Toolbar ............................................... 82</td>
</tr>
<tr>
<td>Multi-User Project .................................... 99</td>
<td>Zoom Palette .......................................... 82</td>
</tr>
<tr>
<td>Multi-User System ..................................... 99</td>
<td><strong>S</strong></td>
</tr>
<tr>
<td>Activating the Project ................................ 107</td>
<td>Scaling .................................................... 14</td>
</tr>
<tr>
<td>Client's Runtime Properties ........................ 103</td>
<td>Select components ..................................... 5</td>
</tr>
<tr>
<td>Connecting a Client .................................. 102</td>
<td>Installation ............................................. 5</td>
</tr>
<tr>
<td>Creating a Multi-User System ..................... 101</td>
<td>Select language ......................................... 4</td>
</tr>
<tr>
<td>Opening a Project on the Client .............. 105</td>
<td>Setting Runtime Properties .......................... 39</td>
</tr>
<tr>
<td>Start Pictures on the Client and Server ........ 106</td>
<td>Setting the Print Job Parameters ................. 89</td>
</tr>
<tr>
<td><strong>O</strong></td>
<td></td>
</tr>
<tr>
<td>Online Table Control ................................ 51</td>
<td>Start Picture Client .................................. 106</td>
</tr>
<tr>
<td>Online Trend Control ................................ 49</td>
<td>Start Picture Server .................................. 106</td>
</tr>
<tr>
<td>Open Page Layout ..................................... 81</td>
<td>Starting the System Wizard .......................... 59</td>
</tr>
<tr>
<td>Operating System ..................................... 1</td>
<td>Starting WinCC ......................................... 12</td>
</tr>
<tr>
<td>Prerequisites .......................................... 1</td>
<td><strong>T</strong></td>
</tr>
<tr>
<td><strong>P</strong></td>
<td>Table Window ........................................... 51</td>
</tr>
<tr>
<td>Print Job ............................................... 88</td>
<td>Creating a Table Window .............................. 51</td>
</tr>
<tr>
<td>Preview .................................................. 90</td>
<td></td>
</tr>
<tr>
<td>Printing a Tag Logging Runtime Report ....... 91</td>
<td>Preview .................................................. 51</td>
</tr>
<tr>
<td>Printing Process Values ............................. 91</td>
<td>Tag .......................................................... 16</td>
</tr>
<tr>
<td>Process Picture ........................................ 11</td>
<td>Tag Groups .............................................. 16</td>
</tr>
<tr>
<td>Configuring the Process Picture ............... 31</td>
<td>Creating a Tag Group ................................ 19</td>
</tr>
<tr>
<td>Creating Process Pictures ....................... 11</td>
<td>Properties of tag group ............................... 19</td>
</tr>
<tr>
<td>Process Value Archive ............................... 46</td>
<td>Tag Logging .............................................. 44</td>
</tr>
<tr>
<td>Creating an Archive .................................. 46</td>
<td>Open Tag Logging ..................................... 44</td>
</tr>
<tr>
<td>Process Values ........................................ 43</td>
<td>Tag Management ....................................... 14</td>
</tr>
<tr>
<td>Creating a Table Window ......................... 51</td>
<td>Tag Simulator .......................................... 8</td>
</tr>
<tr>
<td>Creating a Trend Window .......................... 49</td>
<td>Creating Internal Tags ................................ 17</td>
</tr>
<tr>
<td>Display Process Values ............................. 43</td>
<td>Creating Process Tags ................................ 21</td>
</tr>
<tr>
<td>Program group .......................................... 10</td>
<td>Installation ............................................. 8</td>
</tr>
<tr>
<td>Icons of the program group ..................... 10</td>
<td>linear scaling ......................................... 14</td>
</tr>
<tr>
<td>Project Activate ................................... 40, 77, 90, 98, 107</td>
<td>Tag Properties ......................................... 14</td>
</tr>
<tr>
<td><strong>S</strong></td>
<td></td>
</tr>
<tr>
<td>Scaling .................................................... 14</td>
<td>Using the Simulator .................................. 41</td>
</tr>
<tr>
<td>Select components ..................................... 5</td>
<td>Tags ....................................................... 16</td>
</tr>
<tr>
<td>Installation ............................................. 5</td>
<td>Trend Window .......................................... 49</td>
</tr>
<tr>
<td>Select language ......................................... 4</td>
<td>Creating a Trend Window ............................ 49</td>
</tr>
<tr>
<td>Setting the Print Job Parameters ................. 89</td>
<td>Preview .................................................. 49</td>
</tr>
<tr>
<td><strong>T</strong></td>
<td></td>
</tr>
</tbody>
</table>
U
User Registration ....................................... 3
Installation ............................................. 3

W
WinCC Installation .................................... 2